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What is MarkIt?
MarkIt is an XTension to QuarkXPress that lets you quickly and easily
place press marks, such as trim lines, registration targets, and color and
gray-scale bars, in a QuarkXPress document. A selection of standard
press marks is provided. In addition, you can customize MarkIt by
adding your own marks.

With MarkIt you define MarkIt Styles—each defines placement of a spe-
cific set of press marks. You then assign a MarkIt Style to a QuarkXPress
document prior to printing. Unlike QuarkXPress Style Sheets, MarkIt
Styles are saved with the XTension, meaning all Styles are available in
any document. In addition, when 
a Style is assigned to a particular document, a link to that Style is saved
with the document.

What MarkIt adds to QuarkXPress
When MarkIt is loaded with QuarkXPress, the submenu MarkIt Style is
added to the File menu, the command MarkIt is added to the
Preferences submenu of the Edit menu, and the command MarkIt is
appended to the Edit menu.

The MarkIt Style submenu lets you assign a particular MarkIt Style to
the active QuarkXPress document. The command MarkIt in the
Preferences submenu opens the MarkIt Preferences dialog box which
contains MarkIt’s default settings.
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The MarkIt command appended to the Edit menu opens the MarkIt
Styles dialog box, allowing you to create, edit, save, import, and export
MarkIt Styles. 

All of MarkIt’s enhancements are described on the following pages.

Using this Manual
The manual covers all aspects of MarkIt and follows a structure similar
to the QuarkXPress manuals. Please take a few moments to read this
information—while MarkIt is straightforward and easy to use, all of its
many features may not be immediately apparent. 

This manual assumes that you are already familiar with QuarkXPress
and makes no attempt to guide you in usage of QuarkXPress.
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Installing MarkIt
The MarkIt installer automatically places the XTension in the correct
folder to be run by QuarkXPress.

1. From the Finder, hold down the Shift key as you choose Restart from
the Special Menu; this will disable all extensions including any virus
protection.

2. Insert the MarkIt disk into your floppy disk drive and double-click
the MarkIt Installer icon. When the splash screen appears, hit any key
or click to continue.

3. Click the Install button.

4. A dialog box will prompt you for the QuarkXPress you want to use
MarkIt with. Locate the copy of QuarkXPress select it and click Open.

5. You will now be asked for your name, organization, and serial num-
ber. You can find your serial number on the “Read Me First” card.
Enter the required information and click OK.

6. When the installation process is complete, a message appears indicating
that the installation was successful.

7. Click Quit to exit the installer and return to the Finder. Be sure to store
the MarkIt disk and your half of the registration card in a safe place.

Installing Demonstration Versions
The dialog box displayed after you click Install provides a Demo button
that allows you to install an unserialized, limited-function version of the
XTension. We included this demo to provide a sense of the benefits
available from MarkIt. Feel free to share the installation disk (for demos
only!) with friends and co-workers.

A demo installation of MarkIt will turn QuarkXPress into demo mode.
To get out of demo mode, simply remove the demo version of MarkIt
from your QuarkXPress and/or XTension folder.

Please Note: Documents saved in demo mode (a demo version of
QuarkXPress) cannot be opened by a regular version of QuarkXPress.
We strongly recommend that you duplicate any documents that you
intend to use with a demo version of MarkIt.

A good rule of thumb is never work with original documents when
QuarkXPress is in demo mode and NEVER save over existing documents.
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A Word from ALAP

About Software Copying
Remember: by using this software you have agreed to the software
license — please do not copy the product illegally. If you have multiple
copies of QuarkXPress and you would like to use this software with
them, a site license can be arranged.

Thank You
We extend to you our thanks for your support of this product. It is
important that you understand that a lowly apprentice production, inc.
is a small software company (nowhere near the size of Quark, Inc.). It is
your comments and feedback that lead to improvements to this product.
Please feel free to call or write with any suggestions you may have for
future versions of this XTension and we will put them on our “wish list.”

Also, if you encounter a problem with the software, please let us know
what you did and what the XTension did — only the problems we
know about can be fixed.

And finally, please be sure to send in your registration card so we can
keep you informed about what we are doing.

a lowly apprentice production, inc.
5963 La Place Court, Suite 206 
Carlsbad, CA 92008-8823  USA

Voice: (619) 438-5790
Facsimile: (619) 438-5791

AppleLink: ALAP
CompuServe: 74742,2064
Internet: support@alap.com
America Online: ALAPOnline
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MarkIt Styles
A MarkIt Style defines the placement of a particular set of press marks;
when the Style is assigned to a document, and the document printed,
the selected marks appear in the specified locations on each page.

To create or edit MarkIt Styles, choose the MarkIt command from the
Edit menu. The MarkIt Styles dialog box appears.

MarkIt Styles list
1 – This scrolling list displays the names of all available MarkIt Styles. To
select a Style for editing, duplication, deletion, or export, click its name
in the list to highlight it. Shift-click to select a range of Styles, Command-
click to select multiple, separate Styles, or press Command-A to select all
MarkIt Styles (Command-D deselects all selected Style names).

New
2 – Click New to create a new MarkIt Style; the Edit MarkIt Style dialog
box is presented (described in the following section). Option-click this
button to override the Zoom Window to Screen option in the MarkIt
Preferences dialog box. That is , if Zoom Window to Screen is selected, the
standard-size Edit MarkIt Style dialog box is opened when New is
Option-clicked. Similarly, if  Zoom Window to Screen is not selected,
Option-clicking New causes the Edit MarkIt Style dialog box to be fit
into your monitor screen.

Edit
3 – To edit the highlighted Style, click Edit, press Return, or simply dou-
ble-click its name. The Edit MarkIt Style dialog box appears. Option-
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click this button to override the Zoom Window to Screen option in the
MarkIt Preferences dialog box.

Duplicate
4 – Click this button to create a copy of the highlighted Style. The Edit
MarkIt Style dialog box appears. Option-click this button to override the
Zoom Window to Screen option in the MarkIt Preferences dialog box.

Delete
5 – Click to discard the highlighted MarkIt Style.

Import
6 – To import a file of previously exported MarkIt Styles, click Import. A
standard directory dialog box is presented; locate and select the file to
be imported. If an imported Style has the same name as an existing
Style, “.dup” is appended to the name of the imported Style.

Export
7 – To export one or more MarkIt Styles for transport to another system,
select the Style names in the list and click Export. A standard directory
dialog box is presented; type a name for the exported file and select a
destination folder.

Save
8 – Click to save all changes made to MarkIt Styles and close the MarkIt
Styles dialog box.

Cancel
9 – Click to close the MarkIt Styles dialog box without saving changes
made to MarkIt Styles.

Note: When the MarkIt Styles dialog box is closed, an upside-down
trash can pointer is displayed briefly. This indicates MarkIt is deleting
temporary items and performing other “housekeeping” tasks.

Style preview
10 – If Preview is checked, a “thumbnail” of the highlighted Style is dis-
played. You can click the thumbnail to view the dimensions of the
trimmed page  and the Style page; click again to return to the thumbnail.

2
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Editing MarkIt Styles
The Edit MarkIt Styles dialog box appears when you click New, Edit, or
Duplicate in the MarkIt Styles dialog box.

Mark bar
1 – This scrolling column displays the available press marks. To place a
particular mark, drag from the appropriate icon in the mark bar into the
page preview and position the mark. (The fixed press marks—trim lines
and crop marks—can be turned on and off by simply clicking their
icons in the bar.  Fixed marks are indicated by a red strip at the left edge
of the mark bar.) You also can “Auto Place” marks: Option-click a sym-
bol in the mark bar to display the Auto Place dialog box (described in
the following section “Auto Place”).

Locked marks – A lock symbol slightly below and to the left of an icon
indicates the mark is locked—locked marks cannot be removed from
the bar. To unlock a mark, Command-click its icon to open the Mark
Setup dialog box.
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Deselect the Lock option and close the dialog box.  (When opened from
the mark bar, the Mark Setup dialog box defines “master” attributes for
a mark; that is, each placed mark includes these attributes. The attribut-
es for placed marks also can be changed individually. This procedure is
described in the subsequent section, “Mark Setup.”)

Removing a mark – To remove an unlocked mark from MarkIt, Shift-
click its icon. A warning is displayed if you attempt to delete a mark
used in another MarkIt Style. If you proceed, all occurrences of the
mark are removed from other Styles. The fixed marks (trim lines and
crop marks) and the text marks cannot be unlocked and deleted.

Color strip – The color strip to the left of each mark-bar icon changes to
a checkerboard pattern when that particular mark is in use. The various
colors define groups of marks.

Name
2 – The name displayed in this field depends on the button clicked to open
the Edit MarkIt Styles dialog box. Style names can be up to 32 characters.

Trim Size
3 – These values define the print area of the Style’s page. Values default to
the page dimensions of active QuarkXPress document; if no document is
open, the values specified in the MarkIt Preferences dialog box are used.
The Style page is defined as this print area plus a registration area or trim
margin along each of its sides in which the press marks are placed.

Note: If the Trim Size of a MarkIt Style and the page size of the
QuarkXPress document to which you apply it are not the same, MarkIt
will adjust mark placement so the marks appear in the same relative
positions. (However, for precise mark placement, be sure the MarkIt
Style page size and the document page size match.)
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Scrolling proxy
4 – You can quickly display a particular area of the Style page by click-
ing the corresponding point on this proxy. (Alternately, to scroll the
page you can use the scroll bars, you can drag a mark past the edges of
the page-viewing area, or you can press the Command key, activating
the Grabber, and drag the page.)

Registration area
5 – This value defines the thickness of the registration area or trim mar-
gin that appears along each edge of the print area of the page. The value
can be between 6 pt. and 288 pt. (0.083 in. and 4 in.); the default is set in
the MarkIt Preferences dialog box.

Page bleed
6 – This value defines a bleed zone around the print area of the page.
Trim lines and crop marks are offset this distance from the print area to
allow for page bleed. Minimum value is zero, and maximum depends on
registration-area value (default is set in the MarkIt Preferences dialog box).

Mark coordinates
7 – The X and Y coordinates of the mark currently selected on the page.
To move the mark, drag it to a new location (the coordinates are updat-
ed), or enter new coordinate values. The upper left corner of the trim
area is the zero/zero point.

Magnification
8 – To change the magnification of the Style page, enter a new value in
this field. Magnification can range between 25% and 300%. Click the
magnifying-glass symbol to the left of this field to fit the page represen-
tation in the page-preview area; Command-click the symbol to go to
25% magnification, Option-click it for 50% magnification, Control-click
for 100%, and Shift-click the symbol for 200% magnification. (Refer to
the following “Page preview” section for additional methods of chang-
ing magnification.)

Document page
9 – This pop-up menu lets you choose a page from the active
QuarkXPress document for display in the Style page preview area
(available only if document page size matches Trim Size).
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Mark information
10 – When a placed mark is selected, its name and dimensions are displayed.

Add mark
11 – Click the Add button to add a press mark to the mark bar. A stan-
dard directory dialog box is displayed; locate and select the desired file.
(Press-mark files must be in EPS format.) The mark is appended to the
bottom of the bar.

Page preview
12 – A preview of the Style page, displaying placed marks. A thumbnail
of any page from the active QuarkXPress document can be displayed to
assist you (if document page size and Trim Size match). Choose the
number of the desired page from the Document page pop-up menu.

The page-preview area of the Edit MarkIt Styles dialog box;
dashed lines indicate trim area. Selected mark is indicated by dotted gray lines.

Placing marks – Place a mark by dragging from its icon in the mark bar,
or by using Auto Place (see the following section); the color strip to the
left of the symbol changes from a solid color to a checkerboard pattern.
An existing mark can be duplicated by Option-dragging a copy to a
new location.

Selecting a mark – Click a previously placed mark to select it. The
selected mark is enclosed in a box of dotted lines, and its dimensions,
name, and coordinates are displayed in the dialog box.

Moving marks – To move a mark, you can drag it to a new location, or
you can enter new coordinates. (The X value is the distance from the left
trim edge of the page to the left edge of the mark’s bounding box.
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EDITING MARK I T STYLES

Similarly, the Y value is the distance from the top trim edge to the top of
the mark.) In addition, you can press the Command key and use the
arrow keys to nudge the selected mark to a new location (the mark is
moved the standard QuarkXPress nudge distance), or press Command-
Option and use the arrow keys to move the mark one-tenth of the stan-
dard nudge distance.

You also can reposition an existing mark by double-clicking it to open
the Offset From Page Edge dialog box and entering new distance(s)
from the top and left, or bottom and right of the trimmed page. (The
Offset From Page Edge dialog box can be opened for the selected mark
by pressing Command-M.)

Deleting marks – You can delete any mark by Shift-clicking it; you can
press Command-K to delete the selected mark. To delete all instances of
a particular mark, click that icon in the mark bar.

Magnification – In addition to the methods of changing page magnifi-
cation described earlier, you can:

• Click the magnifier symbol at the intersection of the vertical and
horizontal scroll bars to increase, or Option-click it to decrease, mag-
nification in the percentage increments specified in the MarkIt
Preferences dialog box.

• Press Shift-Command-> to increase, or Shift-Command-< to decrease,
magnification in the percentage increments specified in the MarkIt
Preferences dialog box.

• Press the Control key and click or drag out a marquee in the page-
preview area to increase magnification; displayed area is centered on
the clicked point or the marquee. (Control-Option-click or -drag to
decrease magnification.)

Page scrolling – To scroll a page that doesn’t fit into the preview area,
click a point on the scrolling proxy, use the scroll bars at the bottom and
right sides of the preview area, or press the Command key and drag the
page. (In addition, the page is scrolled automatically when you drag a
mark past an edge of the preview area.)
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Auto Place
Instead of dragging several copies of a mark, one at a time, into position
on the MarkIt Style page, you can use Auto Place to place one or more
instances of a mark in various locations on the page. To Auto Place any
unfixed mark, Option-click that mark’s icon in the mark bar; the Auto
Place dialog box appears.

The Method section, in conjunction with the Apply To section, defines
how and where the marks are to be placed. For example, if Center is
selected, one mark is centered in each side selected in the Apply To sec-
tion. The Edge Offset value defines a distance between the each outer
edge of the Style page and the nearest edge of the related mark’s
bounding box.

When Off Center is selected, the Page Offset field becomes available;
Auto Place marks are moved this distance from the centerpoints of the
selected sides (thus if Page Offset is zero, the marks are centered). A pos-
itive Page Offset value moves the marks clockwise; a negative value,
counterclockwise.

If you select Corners a mark is placed at each intersection of sides select-
ed in the Apply To section. If you select Right of Corners or Left of Corners,
the marks are offset in the specified direction (right is clockwise, left is
counterclockwise) by the amount in the Page Offset field.

The Repeat Count field is available only when Distribute is selected: the
specified number of marks are distributed evenly along each selected
side (if a Page Offset is entered, each mark is shifted accordingly).



Mark Setup
Most of the provided press marks have certain default settings or val-
ues; for example trim-line length and weight, and text-slug information.
You can alter these settings by changing the master Style defaults for a
mark, or by changing them individually, on a placed-mark by placed-
mark basis.

To  change the master attributes for a mark, Command-click its icon in
the mark bar. The trim-line setup dialog box, Text Setup dialog box, or
Mark Setup dialog box is displayed, depending on the icon clicked. All
marks subsequently placed adhere to the new settings.

The trim-line setup dialog box. Trim Line Weight and Trim Line Length
respectively specify thickness and length of crop marks and trim lines.

These checkboxes define the information printed as text slugs. When
Other is selected, you can enter up to 32 characters of additional information.

The Print Spot Plates As option specifies how the mark appears on spot-
color plates:  as a composite of the mark, as only the black, cyan,
magenta, or yellow portion of the mark, or the mark can be skipped.
You also specify that the mark is to be color separated.
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To change the setup for an individual, placed mark, select the mark and
press Command-I to open the appropriate dialog box. (When the Mark
Setup dialog box is opened for an individual mark, the Lock option and
the mark name and dimensions are not available.)

Assigning MarkIt Styles and Printing
A MarkIt Style is assigned to the active QuarkXPress document by
choosing the Style from the MarkIt Style submenu of the File menu.
When the document is printed, the specified press marks appear on
each page.You can turn off press-mark printing by choosing Off from
the Registration pop-up menu in the Print dialog box. The MarkIt Style
however, is still assigned to the document.

Spreads – When printing the QuarkXPress pages as spreads, marks
placed on the left side of the MarkIt Style appear to the left of the left
printed page, right-side marks appear to the right side of the right
printed page, and the top and bottom of the MarkIt Style are repeated
across the top and bottom of each page of the spread (text slugs are not
repeated; they appear only where placed).

Unexpected page centering – Note that in some instances QuarkXPress
will adjust printing so that the print area of a page is centered on the
paper (e.g., when the print area of a page plus the MarkIt Style trim
margins is larger than the printer paper size). If this occurs, some press
marks may be cut off. You can remedy this with manual tiling.
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MarkIt Preferences
The MarkIt Preferences dialog box specifies a number of default settings
for new MarkIt Styles. This dialog box is opened by choosing MarkIt
from the Preferences submenu of the Edit menu.

The MarkIt options are:

Magnification – This is the magnification at which the page preview is
displayed when the Edit MarkIt Styles dialog box is opened.

Magnification Steps – The increment at which magnification is
increased or decreased when you click or Option-click the magnifier
symbol in the lower right corner of the page-preview area, when you
press Shift-Command-> or Shift-Command-<, and when you click in
the page preview with the magnifier tool (press Control or Option-
Control and click or drag).

Trim Line Weight – Defines the default thickness of trim lines and crop
marks.

Trim Line Length – Defines the default length of trim lines and crop
marks.

Page Width – Defines default trim width for new MarkIt Styles; over-
ridden by page width from active document.

Page Height – Default trim height for new MarkIt Styles; overridden by
page height from active document.

Registration Area – Thickness of the trim margin around the page; can
be changed for each Style in the Edit MarkIt Styles dialog box.

Page Bleed – Distance around print area to be left as a bleed zone; can
be changed for each Style in the Edit MarkIt Styles dialog box.
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Page Frame Color – Defines color of dotted line indicating trimmed
page/registration area boundary in page preview. Click box to open
Apple Color Picker.

Page Background Color – Color of page-preview background (area on
which page preview is displayed). Click box to open Apple Color
Picker.

Show Preview of Style – Default setting for Preview checkbox in
MarkIt Styles dialog box.

Zoom Window to Screen – Option-click New button in MarkIt Styles
dialog box.

Knockout EPS Marks – If selected, background of placed marks (area
enclosed by bounding box) is opaque white. Otherwise, background is
transparent and print area of page is visible.

Knockout Text Marks – If selected, background of text slugs is opaque
white.

Limited Page Bleed – If selected, page bleed will be restrited to the
inside of the bleed zone.
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